
Dear Apple Developer,

Here’s the online version of our User’s Guide for Macintosh® Easy Open,

version 1.1. We provide this as a service to you and your new users, so that
you know the important user tasks to cover in your product's user guide.

This guide also shows the language Apple uses to describe the various
elements involved in the file translation process.

There is an electronic version of this guide, in MacWrite II,  on the
Macintosh Easy Open disk. Feel free to use any of this material in the

documentation for the Macintosh Easy Open translation extensions you may
develop.

As you review this guide, you should make note of the following:

• There are warnings throughout the guide urging you to remove the

sample translation extensions for XTND and RTF/styl after you try these as
described in the guide. They work fine for an initial demonstration, but are

beta-release software and may cause your system to crash during repeated
use.

• There are troubleshooting items included in this guide. We encourage you
to send us more items, based on your experience with Macintosh Easy Open.

We can include them in later versions.

And, most of all, thank you for your support for Macintosh Easy Open…the

power to read the rest!

-- Macintosh Easy Open Development Team
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1. Welcome to Macintosh Easy Open

Macintosh Easy Open is a system software extension that lets your system open

a document when you don’t have the program that created it. You can also use

Macintosh Easy Open to convert documents into another program’s format

without opening the documents. This chapter introduces the kinds of new

choices and document information available.

More choices for opening and converting documents

Without Macintosh Easy Open, documents from programs you don’t have

usually can’t be opened. Here’s what you see instead:

clic
k,

clic
k!

Without Macintosh Easy Open, you may 
often see this message, and your only 
choice is to click OK.

Sorry

Macintosh Easy Open makes opening such documents and converting them into a

document format you want as easy as any other basic Macintosh task. It gives

your system the power to find programs that can open a document and list them

for you. You then choose a program that can convert the document using its own

internal translation capability, or one that uses specialized translation

software:

Program A, by itself

Program A, with specialized translation software

Program B, by itself

Program C, with specialized translation software

With Macintosh Easy Open 
 you have new choices for 
       opening a document.

How?
clic

k,

clic
k!
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Although it sets up the conversion process, Macintosh Easy Open does not
actually convert documents. It works with application programs and
specialized translation software that do that. Macintosh Easy Open gathers
information about documents and programs, lists the best options, remembers
your choices, and reminds you of previous choices. With Macintosh Easy Open,
you can experiment with your choices to find the one most suitable for a

particular document. 

More information about documents

Macintosh Easy Open gives your system new information about the great

variety of documents available on personal computers including documents

created with programs you don’t have and documents that were created on

other computers, such as an IBM PC. When you choose (from the View menu) to

view the contents of disks and folders by name, size, kind, or date, you’ll see

detailed information that isn’t there without Macintosh Easy Open. Compare

these examples:

Without Macintosh Easy Open With Macintosh Easy Open
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Macintosh Easy Open lists all your choices of documents you can open when you

are working in an application program. When you choose Open from a

program’s File menu, you may see more documents that can be opened with that

program than when you didn't have Macintosh Easy Open:

Without Macintosh Easy Open With Macintosh Easy Open

A brief summary

Here’s a summary of what Macintosh Easy Open does for you:

• Lets you open documents created by programs you don't have the same way 

you open documents created by programs you do have.

• Searches for alternative programs and translation software on disks

connected to your Macintosh and lets you choose from recommended choices

for opening or converting a document.

• Offers you the option to convert one or more documents to a new format,

without opening them.

• Adds to your list views of files.new information about programs and kinds of

documents, even documents created in DOS or Windows.

The next chapter provides step-by-step instructions for installing Macintosh

Easy Open in your system.
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2. Getting Started

Before you use Macintosh Easy Open, check to be sure that you have what you

need and then install the needed software on your hard disk.

What you need

Before you install Macintosh Easy Open, you should be familiar with your

Macintosh and its operation; specifically, you should know how to use the

mouse and menus and how to work with disks, folders, and files. If you haven’t

had practice with these basic skills, see the learning materials that came

with your computer.

To install and use Macintosh Easy Open, you need a hard disk with Macintosh

system software version 7.0 or later already installed. You’ll also need the

Macintosh Easy Open disk and these instructions.

You probably purchased Macintosh Easy Open because you have specific

translation software that you wish to use with it. Translation software

designed to work with Macintosh Easy Open is the easiest to use and gets the

best translation results. You can find translation software that works with

Macintosh Easy Open at most stores that sell Macintosh software. 

Installing Macintosh Easy Open

These instructions refer specifically to using the Macintosh Easy Open disk to

install the files you need, but they also apply if you do the installation from a

hard disk or over a network connection.

To install Macintosh Easy Open on your hard disk, follow these steps:

1. Start up your computer.

2. Make a copy of the Macintosh Easy Open disk. 

It’s always a good idea to save your original software disk and work with a

copy. Check your license agreement to see how many copies you are allowed

to make for yourself.

3. Insert the copy of your Macintosh Easy Open disk in your computer and open

the disk icon.
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Open the Macintosh 
Easy Open disk on 
your desktop.

If you are installing from a hard disk or over a network, ask your network

administrator for the location of the Macintosh Easy Open files you need.

4. Copy the Macintosh Easy Open Control Panel to the System Folder icon on

the hard disk you use for startup.

Drag this file to your 
System Folder. 

A message appears asking if the file can be placed in the Control Panels

folder within the system folder.

5. Click OK.

Click OK to have the system put
the file in the appropriate place.
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6. Copy the Document Converter to a convenient location on the hard disk you

use for startup.

Drag the Document 
Converter to your 
hard disk. 

In the next chapter you’ll practice using the Document Converter, so you’ll

need easy access to it. 

7. Copy the Macintosh Easy Open Reference to your System Folder.

Drag the reference file to your System Folder.

You won’t ever use the reference file yourself, but it contains program and

document information Macintosh Easy Open needs.
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8. Open the Translation Extensions folder and copy all three sample translation

extension files to your System Folder.

Open the Translation 
Extensions folder and 
drag  the XTND, the 
XTND for applications, 
and the RTF/styl files to 
your System Folder. 

These files are examples of typical Macintosh Easy Open translation

extensions. The XTND and the XTND for applications extension files are

designed to link Macintosh Easy Open to Claris programs and file

translation software. The RTF/styl extension file is an additional file

required for translating material when copying and pasting between certain

programs, such as between Microsoft Word and MacWrite II. 

9. When you see the system message asking to put these extension files in the

Extensions folder, click OK .

Click OK.
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10. In preparation for step 11, open your System Folder and if you don’t see a

folder named Claris , create a new folder with that name.

However, if you already have a Claris folder and it has a Claris

Translators folder in it, be sure to read the note labeled Important in Step 11

before doing that step.

If you don’t have a 
Claris folder inside your 
System Folder, create 
one.

11. Open the Claris XTND Files folder on the Macintosh Easy Open  disk and

copy the Claris XTND System file and the Claris  translators folder to the

Claris folder in your System Folder.

Drag the Claris translation 
software to your Claris 
folder.
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Important: If you already have some Claris translator files in a folder called

Claris Translators, do not replace that folder with the folder on the Macintosh

Easy Open disk. Instead, just copy the individual translator files from the

Macintosh Easy Open disk to your Claris Translators folder. Click OK to

replace the old files with the new improved ones shown below.

If you already have Claris 
Translator files, be sure to replace
only these files.

12. Choose Restart from the Special menu.

The system rebuilds the desktop after you restart and makes the new

information about programs and kinds of documents available for

Macintosh Easy Open to use.

If for some reason you don’t see a message telling you that the desktop is 

being rebuilt, you’ll need to restart again. However, this time hold down both

the Command and Option keys after you choose Restart from the Special menu.

In the future, when you want to install additional file translation software

that works with Macintosh Easy Open, follow the translation product’s

installation guidelines but disregard any instruction to install Macintosh Easy

Open. It’s already installed.Warning: The three sample translation extension

files included with Macintosh Easy Open (XTND, XTND for applications, and

RTF/styl) were created for demonstration only. Don’t use these in your daily

work. When you have finished learning how to use Macintosh Easy Open,

remove these files from your Extensions folder and restart your computer.

You’re ready to use Macintosh Easy Open with the sample file translation

software you just installed. Now turn to Chapter 3, “Using Macintosh Easy

Open,” to learn how. 
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3. Using Macintosh Easy Open
With Macintosh Easy Open you have all the usual ways to open documents on a

Macintosh, to cut and paste between documents, and to use keyboard shortcuts.

Here is what’s new:

• You have choices of programs and translation software to use in opening and

converting documents.

• You can make specialized document converters for fast, direct conversions.

• You can set up Macintosh Easy Open to suit your preferences.

Opening documents

Double-clicking is the easiest way to open a document icon on the desktop. To

see how Macintosh Easy Open works, follow these instructions to open the

sample document, Open Me.

1. Double-click the Open Me icon in the Macintosh Easy Open disk window.

To see how Mac Easy 
Open works, double-click 
this sample document.

By the way: Open Me is a MacWrite, version 5.0, document. If you have the

MacWrite 5.0 program, for the sake of this demonstration you may wish to

remove it temporarily from your system. 
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2. Review the list and click to select your translation preference.

You can select just one choice at a time. Choices you see depend on the kind

of programs and translation software you have available. Often, choices

that include translation extensions offer the best results, but you can always

try another one if you’re not satisfied with your first choice.

With an X in this box, Macintosh Easy Open 
shows just those choices that can produce good 
results.

  MacWrite II can open 
this document by itself.

Macintosh Easy Open tells you the program that
                                     created the document.

3. Click the Open button.  

A progress indicator appears as the document is being translated:

The original document format

The translation
extension in use

The document’s name

The converted document format

Stops a translation in progressIndicates progress
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4. When the document opens, check to see if its formatting is satisfactory.

Macintosh Easy Open renames the document to show that it has been

converted to a new program format.

5. If you wish to save the converted copy, choose Save As…from the File menu

and put the copy in the location of your choice.

If you save this new 
document, you’ll still 
have the original, in the 
original format.

If you don’t like the results of the translation choice you made, you have

some options:

• If you’re sure you don’t want this choice, you can quit the program without

saving the new document and  double-click the Open Me icon again to make

another choice.

• If you want to compare results, you can save the converted document, and

then open the original again  with a different choice.

By the way: Macintosh Easy Open remembers the most recent preference you
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make for each kind of document. The next time you open a document of the

same kind as one  you’ve translated before, you’ll see your most recent

preference for translation highlighted in the list of choices.

About recommended choices

Macintosh Easy Open is set to show only those choices that could produce an

exact, or very close, replication of the original document. However, you may

also have the option to click to deselect the ‘Show only recommended choices’

box and see other possible choices. If you decide to use one of the non-

recommended choices, shown below a line in the list, you’ll need to experiment

to see if the results are satisfactory.

With this option deselected, you may see 
even more choices, added below the line in 
the list.

Choices listed below the line 
cannot  be guaranteed to 
produce optimum results.

If you've made a choice for
opening a similar document 
previously, Macintosh Easy 
Open selects your most 
recent preference in the list.

Sometimes the 'Show only recommended choices' option is not available,

because there are not both recommended and non-recommended choices for a

document.  Here is how Macintosh Easy Open handles those cases:

•When there are no choices that produce optimum results, Macintosh Easy

Open shows choices that could open the document simply as text, without the

original formatting. 

• When there are only recommended choices available, Macintosh Easy Open

just shows those choices. 
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Dragging a document icon to a program icon

With Macintosh Easy Open added to your system, you can open one or more

documents by dragging document icons to the icon of any program with the

ability to open that document. You know the program can open a document if

dragging the document icon to it causes the program icon to highlight. 

When you drag a document 
icon to a program icon that can open 
it, you’ll get the Macintosh Easy Open 
list of choices.

If a program can open the document you drag to it, Macintosh Easy Open will

present its list of available choices. This list will be limited to choices that

include that particular application program and any available translation

software. 

Copying and pasting between programs

Macintosh Easy Open lets you copy and paste between programs by managing

the translation of copied material into a format acceptable in the document

where you paste it. For certain translations, you may need to have a special

scrap translation extension file in your Extensions folder to ensure that all fonts

and styles can be translated with precision. 

You put one of these files, called “RTF/styl,” into your Extensions folder when

you installed Macintosh Easy Open. RTF/styl is a scrap translation extension

file used for translating material from Rich Text Format (RTF) to the “styl ”

format, and vice-versa. For example, with this extension file in your system,

you can copy part of a Microsoft Word file (which uses the RTF format) and

paste it into a MacWrite II file (which uses the styl format) and get a precise

translation. 

Macintosh Easy Open handles automatic updating between programs with the

“publish and subscribe” (automatic updating) capability much the same way

that it handles standard copying and pasting.

Warning: The RTF/styl scrap translation extension file provided for this

16



version of Macintosh Easy Open is for demonstration only and should be

removed from your Extensions folder before you resume your regular work.

Working with a document converter

A document converter is a convenient system utility that you set up to convert

documents to a specific program’s format, without opening the document. Once

you set up a document converter for a particular type of conversion, you can

convert documents easily and quickly, by dragging their icons to the converter

icon. 

Setting up and modifying a document converter

You can have a specific document converter icon for each type of document.

format you want for converted documents. Document converter files require very

little storage space on your disk (about 5 kilobytes each).

Follow these steps to set up a document converter: 

1. Select the Document Converter on your hard disk and choose Duplicate from

the File menu.

Make a duplicate of the
Document Converter icon.

2. Open the copy of the document converter.

Open the new Document Converter.
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3. Click the kind of document you want this converter to create.

A document converter can be set up for only one kind of 
document at a time.

The list shows available 
programs and kinds of 
documents with 
translation software.

A good choice for documents similiar to 
Open Me would be a MacWrite II 
document with XTND.

Not available until 
you make a choice.

4. Click the Set button.

Macintosh Easy Open gives the new document converter an appropriate

name. You can change this name, if you like. 

Macintosh Easy Open changes the name of the 
converter to show the kind of conversion
it performs.

If you want to change a document converter so that it converts documents to a

different document format, open the converter icon again and select a new

option from the list. Macintosh Easy Open changes the converter’s name

appropriately.
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Converting documents

Once you have a document converter set up, it’s easy to use. You can practice

with the original Open Me document:

To convert the document, drag the Open Me icon to the document converter icon

and release the mouse button.

Both icons become highlighted, showing that the conversion has begun.

Drag the sample Open Me icon to 
the new Document  Converter icon.

Macintosh Easy Open creates a copy of the document, adds (Converted) to

the document name, and leaves the original untouched. You can rename the

converted copy whatever you like.

You can rename the converted 
copy whatever you like.

To convert a group of documents to a new format, select the icons and drag them

to a document converter  that you have set up. 

A Document  Converter 
can convert more than 
one document (of the 
same kind) at a time.

You can also drag one or more folders of documents to the document converter.

When converted, the name of the new folder has (Converted) added, but

the documents inside the folder keep their original names.
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Keyboard shortcuts 

You can use standard keyboard shortcuts when working with Macintosh Easy Open

dialog boxes for opening documents and setting up converters. 

Shortcuts:

To do this Take these steps

To select an item, when no item is Type the first letter(s) of the name, or,

already selected: Press the Down arrow key.

To select a different item, Type the first letter(s) of the name, or, 

when one is already selected: Use the Up or Down arrow keys. 

To cancel the dialog box: Press the Command key  and Period key 
(.), or, Press the Escape key (esc).

To confirm the selection Press the Return key  or the Enter key.

in the dialog box:
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Setting up Macintosh Easy Open: your options

You have some options for how Macintosh Easy Open works with your system.

To see your options, open Macintosh Easy Open, located in the Control Panels

folder.

Turns automatic translation 
off and on.

Shows choices even if you've indicated
translation preferences.

Lets the system use programs 
available on file servers. 

Removes the record of your
translation preferences.

Automatically pick if there's only 1 
translation choice.

Always translate documents
of type TEXT.

Options:

On/off

When you don’t need to automatically translate documents in the Finder

and the Open Dialog, you can turn it off. However, as long as Macintosh

Easy Open is on your startup disk, you still see extra information in list

views of files and you can still use your document converters.

Always show dialog box

With Always show dialog box selected, the system presents the list of

choices  for translation even if you have already indicated a preference for

opening a particular kind of document. When you deselect this option,

Macintosh Easy Open uses  the preferences you have established without

asking for confirmation.
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Include applications on Servers

Macintosh Easy Open is normally set to search for programs on all

available disks, even on file servers that you have made available on your

desktop. Using a program on a remote disk over a network could take a long

time. If you would rather have the system search for programs only on hard

disks directly connected to your Macintosh, click to deselect this control.

Auto pick if only 1 choice

Macintosh Easy Open will automatically pick a translation path if there

is only one choice - even if there is no preference indicated for opening a

specific type of document.  If you don't want Macintosh Easy Open to

automatically pick, click to deselect this checkbox.

Translate 'TEXT' documents

Macintosh Easy Open  usually examines all 'TEXT' documents to see if they

are actually plain text or some other file format (for example a PC file that

has just been brought to the Macintosh).  Normally this is checked, and the

examination of 'TEXT' documents will always occur.  Since this check takes

some time, it may be desirable to deselect it, but then documents of type

'TEXT' will be treated as plain text.

Delete Preferences

To erase Macintosh Easy Open’s record of choices you’ve made for specific

translation preferences, click the Delete Preferences button. For instance, if

you get new translation software, it may be convenient to delete all your

previous choices at once and let the system prompt you for each new choice.
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4. Troubleshooting 

If you have trouble using Macintosh Easy Open, read the problems listed in

bold print in this chapter to see if one is similar to your problem. Then follow

the appropriate suggestions.

Important: Apple developers, please send Apple your suggestions for additional

troubleshooting problems and solutions.

When you try to open documents you don’t get the Macintosh Easy Open list of choices.

Check the following:

•    Is the Macintosh Easy Open in your Control Panels folder (inside your

System Folder) and have you restarted your computer since adding this

control panel to the folder?

•    Do you have the required Macintosh Easy Open translation extensions in

your Extensions folder? For this version of Macintosh Easy Open, you need

the XTND, the XTND for applications, and the RTF/styl translation

extension files.

•    Is Macintosh Easy Open turned on in the control panel?

•    Is Always show dialog box selected in the control panel? If it’s not,

Macintosh Easy Open uses your most recent preference instead of showing

the choices.

• Has your desktop been rebuilt since installing new application software?  If

not, rebuild your desktop by restarting your computer while pressing the

Command and Option keys.

•    Does one of Macintosh Easy Open translation extensions you have installed

work with the document you’re trying to open? Remember, Macintosh Easy

Open doesn’t do the translation. It works with the appropriate translation

software. You may need to obtain specific translation software for the

translation in question.
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When you open a document, what you see looks wrong.

Try these possible remedies:

• Try opening the original document again and making a different choice of a

program to translate with.

• If you opened the document without available translation software, try

opening it with translation.

• Does one of the Macintosh Easy Open translation extensions you have

installed work with the document you’re trying to open? Remember,

Macintosh Easy Open doesn’t do the translation. It requires programs with

or without translation software to actually translate documents.

You’ve already made a preference for translating a particular kind of document which

you open often, and you don’t want to see the list of choices.

Choose Control Panels from the Apple ( ) menu and open the Macintosh Easy

Open control panel. Click to turn off ‘Always show dialog box’ (by removing

the X from the box.)

When you choose to open some documents, it takes a long time (more than 3-4 minutes)

to actually open.

If you are on a network and have other disks (such as file servers) accessible

(“mounted”) on your startup disk, Macintosh Easy Open may have presented

you with the choice of a program that is on another disk. If you chose such a

program, the system is using it over the network and consequently the speed of

performance will be determined by network activity. If you don’t wish to use

programs located on disks accessible through a network, you can turn off this

option. (Choose Control Panels from the Apple ( ) menu, then open Macintosh

Easy Open and deselect Include applications on servers by clicking to remove

the X.)

You have an application program on a floppy disk inserted in your computer, but it

doesn’t appear in the Macintosh Easy Open list of choices.

Application programs need to be located on hard disks for use by Macintosh

Easy Open. Copy the program onto your hard disk. (Macintosh Easy Open can

open documents that are located on floppy disks, however).
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When you paste material from one program into a document from another program, you

don’t get the formatting you expected.

In most cases, to get the optimum translation during copying and pasting, you

need a specific scrap translation extension file in your Extensions folder. Check

the documentation that came with your translation extension to see if you need

a scrap translation extension file. If you do need this file, check that it is in

your Extensions folder. If it’s not, add it now. If you have the file in the right

place, and the problem persists, contact the company that makes the

translation extension.

When you use the System 7 “Publish and Subscribe” feature to automatically update

(“publish”) material from one program to another, it updates a document using  the

wrong format.

Macintosh Easy Open handles automatic updating between documents and

programs in Macintosh System 7 much the same way that it handles standard

copying and pasting. You may need a specific scrap translation extension file to

make the required translation.

You’ve added specific translation software to your system but those options don’t show

up in the Macintosh Easy Open list of choices for the document in question.

Here are two things to check:

• Be sure you installed the translation software correctly. See the

documentation that accompanies it.

• The translation software may not be able to do the kind of translation you

expected. Read the documentation or contact the company that makes the

translation software.
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